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1. 개요 
ADE 를 구성하는 방법에 대해 기술합니다. 
 
 

2. 구성요소 
자바 통합개발환경을 만들기 위한 구성요소와 설치방법에 대해 하나하나 살펴 
보겠습니다. 

 

2.1. 디렉토리 생성 

D:\ade_young 이라는 디렉토리를 생성합니다.  D:\ade_young\bin 도 
생성합니다. 여기에 각종 실행파일을 설치할 것입니다. 
 
D:\ade_young\workspace\ws_1 이라는 디렉토리를 생성합니다. 
이클립스로 만든 소스파일과 라이브러리 파일을 저장할 곳입니다. 

2.2. JDK 

http://java.sun.com/j2se/  
에서 다운받습니다. J2SE5.0 을 다운받았습니다. 
http://java.sun.com/j2se/1.5.0/download.jsp 을 참조하시기 
바랍니다. 
설치는 D:\ade_young\jdk1.5.0_05 와 D:\ade_young\jre1.5.0_05 에 
하였습니다. 
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2.3. 이클립스 

 
http://www.eclipse.org/downloads/index.php 
에서 다운받습니다. 버전은 3.1.1 입니다. 
eclipse-SDK-3.1.1-win32.zip 을 d:\ade_young\bin 에 압축을 
풀어넣으면 됩니다. 
 
D:\ade_young\bin\eclipse 의 eclipse.exe 에 대한 바로가기를  
D:\ade_young 에 만듭니다. 

 
 
바로가기의 속성을 다음과 같이 변경합니다. 
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대상 : D:\ade_young\bin\eclipse\eclipse.exe -data 
D:\ade_young\workspace\ws_1 -vm 
D:\ade_young\bin\jdk1.5.0_05\bin\javaw.exe 
(데이터의 위치와 Virtual Machine 의 위치를 지정하여 기동시키라는 명령을 
넣는 것입니다.) 
 
 

2.4. Tomcat 

http://tomcat.apache.org 
에서 다운받습니다. Binary Distribution 으로 제공되는 것 중 설치 없이 
복사만으로 동작하는 버전으로 받겠습니다. 
http://mirror.apache.or.kr/tomcat/tomcat-
5/v5.5.12/bin/apache-tomcat-5.5.12.zip 을 참조하시기 바랍니다. 
 
apache-tomcat-5.5.12.zip 을 d:\ade_young\bin 에 압축을 풀어넣으면 
됩니다. 
 
다음으로, 기동을 위한 파일을 아래와 같이 복사합니다. 
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copy D:\ade_young\bin\apache-tomcat-5.5.12\bin\startup.bat 
D:\ade_young\TomcatStartup.bat 
 
 
복사된 파일의 맨 윗 부분에 다음 내용을 추가합니다. 
 
 
rem -------------------------------------------------------------------- 
rem Suh Hyuck Jun Edited on 2005.11.01 
rem -------------------------------------------------------------------- 
cd D:\ade_young\bin\apache-tomcat-5.5.12\bin 
set JAVA_HOME=D:\ade_young\bin\jdk1.5.0_05 
set CATALINA_HOME=D:\ade_young\bin\apache-tomcat-5.5.12 

 
 
TomcatStartup.bat 을 더블클릭하여 잘 기동되는지 확인합니다. 

 
 
http://localhost:8080 또는 http://127.0.0.1:8080 을 웹브라우저에 
입력해서 다음 화면이 나오면 됩니다. 
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톰캣 종료는 창의 우측상단에 있는 [X] 를 누르면 됩니다. (잠시 ‘프로그램 
끝내기’ 라는 창이 떴다가 사라지는 데 무시해도 됩니다.) 

2.5. Sysdeo Tomcat Plug-in 

http://www.sysdeo.com/eclipse/tomcatplugin  에서 다운받습니다. 
Elcipse 3.1 을 설치했으므로 지원되는 plugin 3.1 beta 를 다운받습니다.  
 
설치는 간단한데, 압축을 풀면 생기는 
com.sysdeo.eclipse.tomcat_3.1.0.beta 폴더를 통째로 
D:\ade_young\bin\eclipse\plugins 에 복사하면 됩니다. 
 

 
 
정상적으로 설치되었는지 확인하기 위해 eclipse 를 기동시켜 봅니다. 
아래와 같이 고양이 모양의 아이콘이 세 개 나오면 잘 설치된 것입니다. 
Plug-and-Play 방식이므로 plugin 디렉토리에 plugin 만 복사하고 
기동하면 저절로 설치가 됩니다. 
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다음은, 디렉토리 설정을 해 보겠습니다. Window > Preferences 메뉴를 
선택한 후, Tomcat 을 누릅니다. 

 
Tomcat Version 을 5.x 로 변경하고, Tomcat Home 을 
D:\ade_young\bin\apache-tomcat-5.5.12 으로 지정합니다. Context 
demlaration mode 는 그대로 둡니다. [Apply] 를 누릅니다. [OK]를 
누릅니다. 
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이클립스에서 톰캣이 기동되는지 확인해 봅니다. 왼쪽 고양이 그림을 
클릭해서 아래화면과 같이 Console 에 나오면 됩니다. 웹브라우저에서 
http://localhost:8080 을 치면 잘 떠야 합니다. 
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2.6. 프로젝트 만들기 

프로젝트를 생성해 보도록 하겠습니다. 이전에는 프로젝트에 “Java 
Project”만 존재하였을 것이나, 플러그인을 설치하였기 때문에 “Tomcat 
Project” 항목이 나타날 것입니다. 

 
 

 
 
Tomcat Project 를 선택한 후 Next 를 눌러 프로젝트의 설정 항목을 
기록합니다.  
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Project name 은 cian3 으로 입력하고 Next 를 누릅니다. 
 

 
Context name 은 http://localhost:8080/[Context name] 에 해당하는 
것이며, 웹 어플리케이션을 구분지어 주는 식별자입니다. 기본적으로 
프로젝트 이름을 그대로 사용하는데 편의상 그대로 두고, Finish 를 
누릅니다. 
 

 
Sysdeo 플러그인이 위 그림과 같이 기본적인 디렉토리를 생성해 준 것을 알 
수 있습니다. 전형적인 WEB-INF 와 jsp 파일의 서블릿 Servlet 변환과 
컴파일 작업이 이루어지는 work 디렉토리가 존재하고, 다시 WEB-INF 
아래에는 lib 디렉토리가 생성되었습니다. 
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몇가지 디렉토리가 보이지 않는데 이는 Eclipse 의 Perspective 를 변경해 
주면 보입니다. 우측 상단에서 위 그림과 같은 아이콘을 찾아 Resources 
Perspective 를 선택하면 디렉토리가 더 명확히 보이게 됩니다. 
(참고:Perspective 는 Eclipse 의 용어로 ‘관점’이라는 의미로 보시면 
됩니다. 여기서는 디렉토리를 어떤 관점에서 보느냐에 따라 모습이 달리 
보인다는 의미로 보면 됨.) 

 
 

 
이제 WEB-INF 밑에 classes, lib, src 디렉토리가 모두 생성되었음을 
확인할 수 있습니다.  
 
Tomcat 홈 디렉토리 하위 conf 에 존재하는 server.xml 파일에 생성된 
프로젝트와 관련하여 <Context> 엘리먼트가 자동으로 추가됩니다.  
 

 
<Context path="/cian3" reloadable="true" 
docBase="D:\ade_young\workspace\ws_1\cian3" 
workDir="D:\ade_young\workspace\ws_1\cian3\work" /> 
 

※ 파일 위치 : D:\ade_young\bin\apache-tomcat-5.5.12\conf 
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여기까지 작업후 Tomcat 을 시동하고 http://localhost:8080/cian3 을 
실행시켜보면 다음과 같은 화면이 나와야 합니다. 

 
 
index.jsp 가 존재하지 않기 때문에 default 로 디렉토리를 보여준 
것입니다. 

 

2.7. Struts Framework 

http://struts.apache.org/acquiring.html 에서 struts 를 
다운로드합니다. 최신 버전은 1.2.7 이며 
http://mirror.apache.or.kr/struts/binaries/struts-1.2.7.zip 
에서 바로 받을 수 있습니다.  
 
Zip 압축을 풀어 lib 디렉토리에 있는 *.tld 를 
D:\ade_young\workspace\ws_1\cian3\WEB-INF 로 복사합니다. 
 

 
struts-tiles.tld 
struts-bean.tld 
struts-html.tld 
struts-logic.tld 
struts-nested.tld 
 

 
다음은, lib 디렉토리에 있는 *.jar 를 
D:\ade_young\workspace\ws_1\cian3\WEB-INF\lib 에 복사합니다. 
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antlr.jar 
commons-beanutils.jar 
commons-digester.jar 
commons-fileupload.jar 
commons-logging.jar 
commons-validator.jar 
jakarta-oro.jar 
struts.jar 
 

 

2.8. web.xml 생성하기 

D:\ade_young\workspace\ws_1\cian3\WEB-INF 에 web.xml 파일을 
만듭니다. 
 

1. Controller 로 사용될 ActionServlet 을 지정(구현은 jar 파일 
내에 감춰져 있음) 

2. MessageResources 설정 
3. struts-config.xml 위치 설정 
4. debug 레벨 설정(3 으로함) 
5. ActionServlet 으로 보낼 URL 유형 설정(*.do 로 함) 
6. 태그 라이브러리 설정(Struts 와 JSTL) 

 
<web-app> 
 
  <display-name>Welcome to Tomcat</display-name> 
  <description> 
     Welcome to Tomcat 
  </description> 
 
  <servlet> 
    <servlet-name>ActionServlet</servlet-name> 
    <servlet-class>org.apache.struts.action.ActionServlet</servlet-class> 
 
    <!-- Resources bundle base class --> 
    <init-param> 
      <param-name>application</param-name> 
      <param-value>MessageResources</param-value> 
    </init-param> 
 
    <init-param> 
      <param-name>config</param-name> 
      <param-value>/WEB-INF/struts-config.xml</param-value> 
    </init-param> 
    <init-param> 
      <param-name>debug</param-name> 
      <param-value>3</param-value> 
    </init-param> 
    <init-param> 
      <param-name>detail</param-name> 
      <param-value>3</param-value> 
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    </init-param> 
    <load-on-startup>1</load-on-startup> 
  </servlet> 
 
  <!-- Board Servlet Mapping --> 
  <servlet-mapping> 
    <servlet-name>ActionServlet</servlet-name> 
    <url-pattern>*.do</url-pattern> 
  </servlet-mapping> 
     
     
  <!-- Struts Tag Library Descriptors --> 
  <taglib> 
    <taglib-uri>/WEB-INF/struts-bean.tld</taglib-uri> 
    <taglib-location>/WEB-INF/struts-bean.tld</taglib-location> 
  </taglib> 
  <taglib> 
    <taglib-uri>/WEB-INF/struts-html.tld</taglib-uri> 
    <taglib-location>/WEB-INF/struts-html.tld</taglib-location> 
  </taglib> 
  <taglib> 
    <taglib-uri>/WEB-INF/struts-logic.tld</taglib-uri> 
    <taglib-location>/WEB-INF/struts-logic.tld</taglib-location> 
  </taglib> 
  <taglib> 
    <taglib-uri>/WEB-INF/c.tld</taglib-uri> 
    <taglib-location>/WEB-INF/c.tld</taglib-location> 
  </taglib> 
  <taglib> 
    <taglib-uri>/WEB-INF/fmt.tld</taglib-uri> 
    <taglib-location>/WEB-INF/fmt.tld</taglib-location> 
  </taglib> 
 
</web-app> 

 
※ JSTL 설정까지 해 두었으니 아래 JSTL 설정과 struts-
config.xml 설정 을 마무리한 후에 톰캣을 기동시키도록 합니다.  
 
[참고] 
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Perspective 에서 복사한 파일이 보이지 않을 경우에는 cian3 에 마우스를 
올려놓고 오른쪽 버튼을 눌러 [Refresh]를 선택하도록 합니다. 

2.9. struts-config.xml 생성하기 

D:\ade_young\workspace\ws_1\cian3\WEB-INF 에 struts-config.xml 
파일을 생성합니다.  
 

 
<?xml version="1.0" encoding="UTF-8"?> 
<!DOCTYPE struts-config PUBLIC "-//Apache Software Foundation//DTD Struts 
Configuration 1.1//EN" "http://jakarta.apache.org/struts/dtds/struts-
config_1_1.dtd"> 
<struts-config> 
 
    <!-- ========== Action Mapping Definitions 
=============================== --> 
    <action-mappings type="org.apache.struts.action.ActionMapping"> 
        <action path="/test" 
            type="cc.struts.cian3.sample2.action.TestAction" 
            scope="request" 
            validate="false" 
            > 
            <forward name="success" path="/jsp/sample2/test.jsp"/> 
        </action> 
 
    </action-mappings> 
 
    <!-- ========== Controller Configuration 
================================ --> 
    <controller /> 
 
    <!-- ========== Message Resources Definitions 
============================ --> 
    <message-resources parameter="MessageResources" /> 
 
    <!-- ========== Plug Ins Configuration 
================================= --> 
</struts-config> 
 

2.10. Eclipse 에 library path 설정하기 

이클립스에서 컴파일을 위한 외부 라이브러리 path 를 설정해 줍니다. 
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Project > Properties 를 클릭합니다. 
 

 
Library 탭을 선택하고 [Add Jars]를 선택합니다. 
 

 
cian3\WEB-INF\lib 를 눌러 모든 *.jar 를 선택하고 [OK]를 누릅니다. 
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[OK]를 누릅니다. 
 

2.11. 샘플 만들기(Action 클래스) 

Struts 가 동작하는지 테스트를 위한 샘플을 만들어 보겠습니다. 
D:\ade_young\workspace\ws_1\cian3\WEB-
INF\src\cc\struts\cian3\sample2\action 디렉토리가 생성되도록 
합니다. 
 
다음과 같은 내용의 TestAction.java 파일을 만듭니다 
 

 
package cc.struts.cian3.sample2.action; 
 
import org.apache.struts.action.Action; 
import org.apache.struts.action.ActionForward; 
import org.apache.struts.action.ActionMapping; 
import org.apache.struts.action.ActionForm; 
import javax.servlet.http.HttpServletRequest; 
import javax.servlet.http.HttpServletResponse; 
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public final class TestAction extends Action { 
  
    public ActionForward execute(ActionMapping mapping, 
                                 ActionForm form, 
                                 HttpServletRequest request, 
                                 HttpServletResponse response) 
        throws Exception { 
         
     return (mapping.findForward("success")); 
         
    } 
} 

 
 요청을 받으면 바로 success 로 포워딩하는 단순한 Action 입니다. 
 

2.12. 샘플 만들기(jsp) 

D:\ade_young\workspace\ws_1\cian3\jsp\sample2 디렉토리가 
생성되도록 합니다. 디렉토리에 test.jsp 파일을 다음 내용으로 생성합니다. 
 

 
<%@ taglib uri="/WEB-INF/struts-bean.tld" prefix="bean" %> 
<%@ taglib uri="/WEB-INF/struts-logic.tld" prefix="logic" %> 
<%@ taglib uri="/WEB-INF/struts-html.tld" prefix="html" %> 
<%@ page contentType="text/html;charset=euc-kr" %> 
<html> 
<head> 
</head> 
<body> 
If you can see this, struts works! 보이면 성공한 것임. 
</body> 
</html> 
 

 

2.13. 샘플 테스트 

톰캣을 기동하고 http://localhost:8080/cian3/test.do 을 입력하면 
다음과 같이 나와야 합니다. 
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2.14. JSTL 

http://mirror.apache.or.kr/jakarta/taglibs/standard/binaries/
jakarta-taglibs-standard-1.1.2.zip 에서 다운받습니다. 
http://jakarta.apache.org/site/downloads/downloads_taglibs-
standard.cgi 사이트가 메인입니다. 
 
Zip 압축을 풀어 lib 디렉토리에서 *.jar 를 
D:\ade_young\workspace\ws_1\cian3\WEB-INF\lib 에 복사합니다. 

 
jstl.jar 
standard.jar 
 

 
풀린 파일 중 tld 디렉토리에서 다음 tld 파일을 
D:\ade_young\workspace\ws_1\cian3\WEB-INF 으로 복사합니다. 

 
c.tld 
fmt.tld 
 

 
이클립스 프로젝트를 Refresh 해 주고, Project > Properties 의 Java 
Build Path 에서 [Add JARs] 를 누릅니다. 

 
 
cian3\WEB-INF\lib 의 *.jar 를 선택하고 [OK]를 누릅니다. 
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아래와 같이 library 가 추가되면 [OK] 를 누릅니다. 
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2.15. Database 

http://www.mysql.com/ 
에서 다운받습니다.Mysql 5.0 Community Edition 을 다운받도록 
하겠습니다.  
http://dev.mysql.com/downloads/mysql/5.0.html 을 참조하시기 
바랍니다. Without installer (unzip in C:\) 을 다운로드하겠습니다. 
 
mysql-noinstall-5.0.15-win32.zip 을 d:\ade_young\bin 에 압축을 
풉니다. 
 

 
D:\ade_young\bin\mysql-5.0.15-win32 에 위와 같은 디렉토리가 풀려야 
합니다. 
 
다음은 option file 을 생성하는 단계입니다. C:\my.ini 라는 파일을  
아래 내용으로 생성합니다. 

 
[mysqld] 
# set basedir to your installation path 
basedir=D:/ade_young/bin/mysql-5.0.15-win32 
# set datadir to the location of your data directory 
datadir=D:/ade_young/bin/mysql-5.0.15-win32/data 

 
 
Basedir 은 mysql 이 설치된 위치이며, 여기서는 압축을 푼 위치가 됩니다. 
Datadir 은 테이블과 데이터 등이 저장된 위치를 기리키는데, 기본위치를 
지정합니다. 옮기고 싶다면, D:/ade_young/bin/mysql-5.0.15-
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win32/data 의 파일과 디렉토리들을 원하는 위치로 이동한 후 my.ini 의 
내용을 변경하면 됩니다. 
참고로, option file 에서 디렉토리는 백슬래쉬(\) 가 아닌 슬래쉬(/)로 
해야 합니다. 백슬래쉬로 하고 싶은 경우에는 쌍(\\)으로 합니다. 
 
자세한 설명은 http://dev.mysql.com/doc/refman/5.1/en/windows-
extract-archive.html 을 참조하시기 바랍니다. 
 
MySQL 은 항상 백그라운드로 실행되는 것이 편리하므로 윈도서비스로 
등록하는 절차를 알아보겠습니다. 도스창에서  
 

 
D:\ade_young\bin\mysql-5.0.15-win32\bin\mysqld-nt –install 
 

을 입력해 주면 아래와 같이 윈도 서비스에 등록이 됩니다. 단, 기존에 
서비스로 등록되어 있는 것이 있다면 아래의 [참고-서비스 삭제방법]을 먼저 
실행하여 주시기 바랍니다. 
 

 
  

내컴퓨터 > 관리 > 컴퓨터 관리 로 이동하여 보면 아래와 같이 MySQL 
서비스가 추가되었을 것입니다. 시작유형이 ‘자동’으로 되어 있으므로 윈도 
부팅시 항상 MySQL 이 기동됩니다. 그러나, 최초에는 윈도 부팅을 하지 
않고 진행할 것이므로 강제로 ‘시작’을 시켜 줍니다. 
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[참고-서비스 삭제방법] MySQL 을 서비스에서 삭제할 때에는  
 

 
D:\ade_young\bin\mysql-5.0.15-win32\bin\mysqld-nt –remove 
 

라고 입력해 주면 됩니다. 
 
MySQL 이 잘 동작하는 지 테스트해 보도록 합니다. 

 
위와 같이 도스창에서 입력해 보시기 바랍니다. 만약, 암호를 물어보면 그냥 
엔터를 칩니다. 설치 초기에는 암호가 없습니다. 
 
아래와 같이 결과가 나오면 MySQL 이 잘 설치된 것입니다. 
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보안을 위하여 root 유저의 암호를 변경하도록 합니다. MySQL 은 mysql 
데이터베이스의 user 테이블에 사용자정보를 관리하며, 사용자 
생성/수정/삭제를 위한 명령어를 제공하지 않으므로 update 쿼리로 수정하면 
됩니다. 
 

 
use mysql;  (데이터베이스를 선택하는 명령으로, 위에서 입력했다면 생략 가능) 
 
update mysql.user set password=PASSWORD('pokipoki') where user='root' and 
host='localhost'; 
 
flush privileges; 

 
 
flush privileges; 명령어는 update 결과를 privileges 에 반영하라는 
뜻입니다. 
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변경이 되었는지 보려면 select host, user, password from user; 로 
확인해 볼 수 있습니다. 
 
MySQL 을 종료할 때에는 exit 라고 입력하면 됩니다. 종료하더라도 MySQL 
서비스는 윈도가 종료될 때까지 계속 데몬으로 존재합니다. 

 

 
root 유저에 암호가 생성되었으므로, 도스창에서 MySQL 에 접속하려면 
아래와 같이 입력하면 됩니다. 
 

 
mysql –u root –p 
 
암호입력 <Enter> 
 

 
[참고] 도스창의 아무 디렉토리에서나 mysql 명령어가 동작하도록 하려면 
시스템 변수 path 에 경로를 추가해 주어야 합니다. 

2.16. MySQL Connector 

http://www.mysql.com/products/connector/j/ 에서 다운받습니다. 
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http://dev.mysql.com/downloads/connector/j/3.1.html 현재 
recommend 되는 버전은 3.1 입니다. 
 
압축을 풀면 mysql-connector-java-x.x.xx-bin.jar 라는 파일이 
있습니다. (현재 버전은 3.1.11 입니다.) 이 파일을 
D:\ade_young\workspace\ws_1\cian3\WEB-INF\lib 에 복사합니다.  

 
이클립스를 실행시켜 이클립스 프로젝트를 Refresh 해 줍니다.  

 
 
그 다음, Project > Properties 의 Java Build Path 에서 [Add JARs] 
를 누릅니다. cian3\WEB-INF\lib 의 *.jar 를 선택하고 [OK]를 누릅니다. 

 
 
아래와 같이 library 가 추가되면 [OK] 를 누릅니다. 
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2.17. 자바소스에서 MySQL 테스트 

<작성예정> 

2.18. Logging 

http://jakarta.apache.org/commons/logging/ 에서 다운받습니다. 
1.0.4 버전을 받도록 합니다. 
http://jakarta.apache.org/site/downloads/downloads_commons-
logging.cgi 에서 바로 받을 수 있습니다.  
<작성예정> 
 

2.19. 쿼리문 Logging 

<작성예정> 
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2.20. Character Encoding Filter 

<작성예정> 
 
 

2.21. property editor 

<작성예정> 
 

 

2.22. MySQL 조회를 위한 Tool 

<작성예정> 
 
 

 


